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Introduction 
 
This document is a brief introduction to the Calendar feature of the NEOUCOM DOCS Portal. 

Overview 
 
To access your calendar: 
1. Login to the NEOUCOM DOCS Portal at http://DOCS.neoucom.edu 
2. Click on the Calendar icon. 
 
 
 
 
3. Your calendar will now be displayed. 
 
When you first open your calendar, you will see the following window. This is the Overview view of 
your calendar. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
The following is a brief description of the Overview window. 

View tab 
Click on this tab to view your calendar(s) in different ways. The figure shown is the “Overview” view. 
The shaded area will display whatever is on your calendar for today. The area immediately below will 
display the events you have in the coming week. You can also view your calendar one day at a time, 
one week at a time, one month at a time, or one year at a time by clicking on the appropriate links 
(day, week, month, year). Note that the year view will not display the events on your calendar, just 
show you a calendar of the entire year. 
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The comparison link is most useful when you are viewing a calendar set. A calendar set is calendars 
you’ve subscribed to, that you have decided should be put into one set together. This is usually so 
you can see everyone’s busy and available times at a glance, without looking at each calendar 
individually. 

Calendars tab 
Click on this tab to create or subscribe to calendars. You can create more than one calendar for 
yourself (e.g. one for school items, one for personal items). You may also subscribe to other 
calendars (e.g. your friends or co-workers) if they’ve granted you access privileges. Once you’ve 
created or subscribed to calendars, you can access them under the “Current Calendar” drop-down 
menu under the View tab. 

Calendar Sets tab 
Click on this tab to create calendar sets. Calendar sets are calendars that you’ve chosen to group 
together so that you may see more than one person’s availability at a chosen time. For example, you 
may manage student assistants and want to group all their calendars together to see when all are 
available for a meeting. 

Options tab 
Click on this tab to change your global calendar settings such as the start/end time of your work day, 
whether you want to be emailed reminders, and other options. You can also use this tab to import or 
export data in iCal or XML format. XML is a specific format for displaying a web page, while iCal is a 
format for calendar data (usually used with PDAs). 

Action Items 
This section on the lower right side of the screen is where you would check to see if you have any 
meeting invitations you need to reply to, tasks due that day, or errors in your calendar. 

New event icon 
Click on either New Event icon to create a new event or meeting on your calendar. You can also click 
on this icon anywhere you see it in your calendar, to create a new meeting or event. 
 
 

New task icon 
Click on this icon to create a new task. 
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Jump to icon 
Click on this icon to quickly jump to another day or year. Once you’ve clicked on this icon, you will see 
the following screen: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
You can either type in the date you wish to jump to, select a day from the displayed month by clicking 
on it, select a different month from the current year by clicking on its name, or jump to another year by 
clicking on the yellow triangles. Once you have selected the date you wish to jump to, click on OK. 
You can also access this “Jump to date” window anytime you see this icon while creating an event or 
task: 
 
 
 

Printable 
Click on this icon to get a printable view of your calendar. This will change depending on what view 
(day, week, month) you are in before clicking on this icon. 

Search 
Click on this icon to search your calendar for a specific event or task. Note: the results will not be in 
chronological order. 

Navigating through your calendar 
Clicking on the yellow triangles all the way on the left will take you back or forth depending on what 
view you are in. If you are in the weekly view, it will take you back and forth one week. In the 
“Overview” view shown, it will take you back and forth one day. You can also use the small month 
calendar to the right to navigate around; click on the day of the month you want to view, or click on 
the yellow triangles to go back and forth by months.   
 
Click on Exit (upper right) to exit your calendar.  
 
Click on Help for on-line calendar help. There is extensive on-line help available. Please refer to this 
on-line help first for any questions not answered by this document. 
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Setting Global Calendar Options 
 
1. Click on the Options tab. 
 
2. This is where you can change various options for your calendar. 

Group Invitations 
By default, if you are viewing a calendar set and you create an event on that set, it will 
automatically send a meeting invitation to all the people who are a part of that set. If you do not 
want this to happen, uncheck this box. 

Date 
If you want to change the format of your dates from month, day, year select a different format 
from the popup menu. 

Time 
Select either 12 hour clock or 24 hour clock as you prefer. 

Day 
a. Select the start and end times of your day. 
b. Select how you want to split your days. If you split your days on the half hour, your day at-a-

glance and week-at-a-glance views will show times in that increment (7am, 7:30am, 8am, 
etc) 

 
Note: The start and stop times can only be on the hour. So a start time of 7:45am is not possible. 

First day of the week 
Choose what day you want to be on the leftmost column in all of your views. You may want to 
change this to Monday if that is the first day of your work week; then Saturday and Sunday will be 
grouped together on the right. This option will be most obvious in the week-at-a-glance and 
month-at-a-glance views. 
 
If you wish, you can check the box for Exclude Saturday and Sunday if you do not wish to see 
those days displayed in your weekly or monthly views. 

Time Zone 
This is the global time zone setting. All calendars you create will be displayed in this time zone 
unless you change the individual calendar’s time zone. By default, it is set to Eastern Standard 
Time. 

Event and Task Reminders 
You can setup your calendar so that by default, you are reminded about all meetings, events, and 
tasks. You can also disable the global reminder option, and set a reminder event-by-event. 
To setup a global reminder: 
 
a. Check the box next to Email me a reminder… Type the amount of minutes, hours, or days 

before each event that you wish to be reminded. 
 
b. In the box below, type the email address you want the reminder sent to. If you want the 

reminder sent to more than one email address, type in each address separated by commas 
or semi-colons. 
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Event Notifications 
You may want to be emailed anytime someone else schedules something on your calendar. For 
example, if you get invited to a meeting or if you have a secretary and that person edits your 
calendar. To enable this feature, check the box next to Email me a notification. In the box 
below, type the email address (only one is allowed for this option) that you want the message 
sent to. 
 

3. If you’ve made any changes to the above options, be sure to click on the Save Changes button 
or you will lose all your changes. 

Creating a new event 
 
An event is time you need to reserve on your calendar, either for an activity that you need to do 
yourself, or a meeting. 
 
1. There are two ways to create an event. Click on the          icon closest to the day or time of the 

event, or click on the New Event icon. 
 
2. If you have different calendars (such as one for personal and one for work events) you may click 

on the Calendars pop-up menu and choose the calendar to put the event on. You can only put 
the event on one calendar. 

 
3. In the Event Title box, fill in a title for the Event, such as Planning Committee meeting. 
 
4. In the Date box, type in the date for your event. If you wish, you may click on the icon to “jump to” 

a specific date. 
 
5. In the Time box, fill in the start time and duration of your activity. 
 

Note that the All day option does not reserve the entire day as it would seem. This option is for 
creating a “banner” at the top of your calendar that you can use to show that something is 
occurring on that day (e.g. you could use this to mark off the days for Spring Break). If you want 
to block off your whole day, type in enough hours in the duration boxes to cover your work day. 

 
6. If this is a re-occurring event, select the Repeat option. See the section, Setting the Repeat 

Option for more information on how to setup a repeating event. 
 
7. Under the Privacy pop-up menu, select the level of privacy you want for this event. If you select 

Public Event, then everyone with Read access to your calendar can see the date, time, title, and 
other information about this event. If you select Time and Date Only, then everyone with Read 
access to your calendar can only see the time and date of the event. All other information about 
the event, including the title, will not be seen. If you select Private Event, then nobody but you 
can see the event on your calendar. It will be completely invisible to others; you will appear to be 
free during that block of time. 

 
 
8. In the Location box, type the location for the activity or meeting. In the Description box, you can 

type notes about the event, or an agenda for a meeting. 
 
9. If this event is a meeting, type the NEOUCOM Username of the person you wish to invite in the 

box located under the Invite other users or resources section, then click on the Invite button. If 
you wish to simply inform the person of the meeting, click on the Inform button. [In general, 
“Invite” means their presence is required at the meeting, while “Inform” means that you want the 
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person to know about the meeting, but they are not required to attend.] Their name will then 
appear in the Invitees (or Inform about Event) box. 

 
If you do not know the NEOUCOM Username of the person you are inviting, click on the Search 
to Invite button. A search window will appear. Type the name of the person you wish to invite into 
the box, and click on Search. You will get a list of results. Check the box next to the person you 
wish to invite, then click on the Invite button. Their name will then appear in the Invitees box. 

 
To search for a person to inform about this event, follow the same steps, except start by clicking 
on the Search to Inform button. 

 
10. If you wish to have a reminder for this event emailed to you, click on the Reminders tab. In the 

appropriate boxes, type in the email address where you wish to receive the reminder, as well as 
the date and time of when you want to be reminded. If you do not wish to receive a reminder, 
uncheck the Remind box. 

 
11. If you are scheduling a meeting, the Availability tab will show you if the people you’ve invited are 

free or busy at the time you’ve scheduled the meeting. 
 
12. Click on the Preview tab to see a preview of what your event/meeting looks like, and the 

information it contains. If this is a meeting, it will also show a list of invitees. After you’ve sent this 
invitation, you can look at this tab again to see who’s accepted/declined your invitation. 

 
13. Click on OK. The event/meeting will now appear on your calendar. If you invited other people, 

they will see your invitation under their “Action Items” section the next time they open or refresh 
their calendar. 

Creating a new task 
 
1. Click on the New Task icon. 
 
2. If you have different calendars (such as one for personal and one for work events) you may click 

on the Calendars pop-up menu and choose the calendar to put the task on. You can only put the 
task on one calendar. 

 
3. In the Task Title box, type a name for the task, for example, Write calendar document 
 
4. In the Due Date box, type the due date for this task. If this is an ongoing task, check the Not Due 

box. 
 
5. In the Time box, type the time that the task is due. If there is no set time, check the No Time box. 
 
6. If this is a repeating task, select the Repeat option. See the section, Setting the Repeat Option for 

more information. 
 
7. Under the Privacy pop-up menu, select the level of privacy you want for this event. If you select 

Public Task, then everyone with Read access to your calendar can see the date, time, title, and 
other information about this task. If you select Time and Date Only, then everyone with Read 
access to your calendar can only see the time and date of the task. All other information about 
the event, including the title, will not be seen. If you select Private Task, then nobody but you can 
see the task on your calendar. 

 
8. If applicable, fill in the Location and Description boxes. 
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9. If you wish to have a reminder for this task emailed to you, click on the Reminders tab. In the 
appropriate boxes, type in the email address where you wish to receive the reminder, as well as 
the date and time of when you want to be reminded. If you do not wish to receive a reminder, 
uncheck the Remind box. 

 
10. Click on the Preview tab to see a preview of what your task looks like, and the information it 

contains. 
 
11. Click OK when you are finished creating your task. 

Setting the Repeat Option 
 
You can follow this procedure anytime you select the Repeat option when creating a new event or 
task. 
 
1. When creating a new event or task, select the Repeat option. 
 
2. The Recurrence window will appear. You have a choice of repeat patterns -- Daily, Weekly, 

Monthly, or Yearly. The options in the box to the right will change depending on which repeat 
pattern you select. If you are trying to create a birthday event, you might want to select the yearly 
option. If you are marking off vacation days on your calendar, you might want to select the daily 
option. 

 
In the following example, we will use the Weekly option, but the same principles apply to the other 
options. Select the Weekly option. 

 
3. You can choose to repeat the event either every week (the event will repeat every week) or every 

XX week (the event will repeat every so many weeks, depending on what number you type in the 
box) 

 
4. Under the Repeat on option, select the day of the week that you want the event to occur on. 
 
5. Under the Start section, type the first date of the event. 
 
6. Under the End section, type the last date of the event. Or, if the event will be a certain number of 

occurrences (say a 10-week course) you could type 10 in the Create XX events box. If this event 
does not yet have an end date, you can select No end date (selecting this option will create a 
maximum of 200 events). 

 
7. Click OK to set the repeat pattern. 

Editing an event 
Editing an event 
To edit an event, click on its name (it should be blue and underlined). You can now edit the event the 
same way you would edit a new event. 
 

• If it is a repeating event, you can change the repeat pattern by clicking on the Change repeat 
pattern link. 

 
Click OK to save any changes. If it is a repeating event, you will be asked if you want to apply the 
changes to just this one event, or this and all future events. If you want to apply the changes to just 
the one event, click on the This one only button. If you want to apply the changes to this and all 
future events, click on the This and future ones button. 
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(  ) 
Deleting an event 
You can delete an event in two ways. The first way is to click on the red x          that appears next to 
the title of the event you wish to delete. You will be asked if you are sure you want to delete the 
event. If you are, click OK, else click Cancel. Note: clicking on the red x does not work in Internet 
Explorer on the Macintosh. 
 
The second way would be to click on the title of the event you wish to delete (it should be blue and 
underlined). In the window that appears, click on the Delete button in the lower left corner. You will be 
asked if you are sure you want to delete the event. If you are, click OK, else click Cancel. 
 
In both cases, if you are deleting a repeating event, you will be asked if you want to delete just this 
one event, or this and all future events. If you want to delete just the one event, click on the This one 
only button. If you want to delete this and all future events, click on the This and future ones button. 

Editing a task 
 
1. If necessary, click on the Overview link so you can see your Action Items section. 
 
2. Under the Action Items section, click on Tasks. 
 
3. The Task List window will appear with a list of tasks. If the Task is completed, you can check the 

Done box next to its name. If you want to delete the task, check the Delete box next to its name. 
To edit a task, click on its name (it should be in blue). The task will open, and you can edit it as 
you would a new task. 

 
4. Be sure to click on the OK (if editing a task) or Save and Close button (if editing the Task List) to 

save any changes. 

Creating a new calendar 
 
You can create as many calendars as you want, and use them for different purposes. For example, 
you could have one calendar for work items, one calendar for personal items, another calendar for 
your child’s sports events, and so on. 
 
1. Click on the Calendars tab 
 
2. Click on the New Cal icon 
 
3. In the Calendar Identifier box, type a short name (no spaces) for your new calendar. The 

Calendar Identifier is a very short description of what the calendar is for, or some way to identify 
this calendar. The Calendar Identifier for each calendar you create must be unique. This identifier 
will appear when you view calendar sets that include this calendar. 

 
4. In the Display Name box, type a name for your calendar, for example, Personal. 

 
Note: your full name will automatically be pre-pended to the name of any calendar you create. 
This is to avoid people creating calendars with the exact same name. 

 
5. Change other options as you wish (see the sections Granting permission to view your calendar 

and Individual calendar options for more information on these options). When you are finished, 
click OK. Your new calendar will be created and will appear in your list of subscribed calendars. 
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6. To view your new calendar, click on its name (the name should be blue and underlined). You can 
also view the calendar by clicking on the View tab, then selecting the calendar’s name from the 
Current Calendar drop-down menu. 

Subscribing to a calendar 
 
If you would like to see someone else’s calendar, you need to subscribe to it. The person must first 
grant you rights to their calendar or you will be unable to see anything. 
 
1. Click on the Calendars tab. 
 
2. Click on the Subscribe icon. 
 
3. In the Search box, type the first or last name, or the NEOUCOM Username, of the person whose 

calendar you want to subscribe to, then click on Search. 
 
4. A list of results matching what you typed will be returned. Check the box next to the calendar you 

wish to subscribe to. If you do not get the result you wanted, try again with less characters in the 
search string. If you still get no results, it’s possible the person has not used their calendar yet, or 
they have disabled the Everybody option from accessing their calendar and not given you access. 

 
5. Click on OK. The person’s calendar will now be listed in your list of calendars. 
 
6. To view the person’s calendar, click on their name (their name should be blue and underlined). 

 
You can also view a person’s calendar by clicking on the View tab, then selecting the calendar 
from the Current Calendar drop-down menu. Note that if the person has not given you access to 
their calendar, you will be able to open their calendar and may check their availability, but no 
items on their calendar will be displayed. 

Granting permission to view your calendar 
 
By default, Everybody (all users of the portal) subscribe to your calendar and see if you’re busy or not 
(but not the items you’re actually busy with) and invite you to meetings. To change these permissions, 
or to grant specific people different levels of access, follow these steps. 
 
1. Click on the Calendars tab. You will see a list of the calendars you are subscribed to, or that you 

have created. To change a specific calendar’s options, click on the Edit link to the right of its 
name. Note: you can only change permissions (and other options) for your calendar and 
calendars you have created. 

 
2. Another window will open with the Calendar tab options displayed. Click on the Permissions tab. 

These are the different types of access you can grant someone. 
 

• Availability  the person can tell if you are busy or not. If you are busy they will not be able 
to see why; just that the time is blocked out. 

 
• Invite  the person can invite you to meetings 
 
• Read the person can view your calendar (and all events) but not edit anything. 
 
• Delete the person can delete events from your calendar (only works if you have also 

given Read permission) 
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• Modify  the person can modify events that are on your calendar (only works if you 
have also given Read permission) 

 
3. To give someone access, type their NEOUCOM Username in the User Name box, and click on 

Add User. After they have been added to your list, check the appropriate boxes for the type of 
access you wish to give them. 

 
4. Click on OK. The person now has the access rights you granted them. 

Individual calendar options 
Calendar tab 

• The Display Name is a way to differentiate different calendars you may have created. In this 
box, you should type something that describes the calendar’s purpose, such as “work”, 
“personal”, “tennis team schedule” etc. 

 
• The Description is a description of what the calendar is for. 

Owners tab 
This is where you can designate someone as an owner to your calendar, and they may act on your 
behalf. You may want to do this if you will be away from your calendar for an extended period of time.  
 
To add another owner, type in the person’s NEOUCOM Username in the Owner Name box and click 
on the Add Owner button. 
 
To delete an owner, check the box next to the person’s name and click on Delete Owner. 

Time Zones tab 
To change the time zone of a specific calendar you have created, click on this tab, and select a new 
time zone. To save any changes, click on OK. 

Creating a calendar set 
 
Calendar sets are calendars you’ve subscribed to, that you have decided should be put into one set 
together. This is usually so you can see everyone’s busy and available times at a glance, without 
looking at each calendar individually. For example, if you have five student assistants, you might wish 
to create a calendar group with all five of their calendars so you can see at a glance when all five are 
available. 
 
Note: you must be subscribed to the person’s calendar before you can add it to a calendar set. 
 
1. Click on the Calendar Sets tab. 
 
2. Click on the New Set icon. 
 
3. In the Set Name box, type a name that describes your calendar set, such as Student Calendars. 
 
4. Leave the Calendar ID box blank. 
 
5. Under the Quick Add pop-up menu, select the first calendar that you wish to add to the set.  

Keep doing this until all calendars you want in the set have been added. The calendars you have 
added will appear in the Set Members box. 
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6. If this calendar group should use a different time zone than the default time zone, click on the 

Time Zone tab and choose the appropriate time zone. 
 
7. When you are finished, click on OK. The set should now be listed under your Calendar Sets tab. 
 
To view your calendar set, click on its name under the Calendar Sets tab or click on the View tab 
and select the set from the Current Calendar drop down menu. If necessary, click on the 
Comparison link. This will show you all the calendars at once, and you will be able to see when 
everyone is busy or available. 

Known Calendar issues 
 

• If you are in the View tab, then go somewhere else (say the Calendar Sets tab), when you 
click back on the View tab, you return to the default view (Overview), not the view you were 
in. 

 
• There are no customizable print layout features, such as the ability to print out the day’s 

schedule on 3x5 index cards. 
 

• You can only start and end days on the hour. 
 

• If you want to subscribe to someone’s calendar, they need to have opened their calendar at 
least once, or your search for their calendar will return no results. 

 
• There is no easy way to keep track of the meetings you have initiated. 

 
• There is only PC syncing for PDAs. There is no Macintosh syncing for PDAs. 

 
• Macintosh users do not receive the “timeout” warning unless they are using Netscape. 

 
• Clicking on the red x to delete an event does not work in Internet Explorer on the Macintosh. 

 
• When you search your calendar(s), the results are not displayed in chronological order. 

Getting Help 
 
Click on the Help link (usually in the upper right hand corner of the window) for on-line calendar help. 
There is extensive on-line help available. Please refer to this on-line help first for any questions not 
answered by this document. 

Additional Help 
 
 For additional assistance, please phone IT Desktop Support at (330) 325-6911, 

send email to help@neoucom.edu, or fax (330) 325-5928. 
 

Or see the IT Desktop Support home page at www.neoucom.edu/IT/help 
The IT Desktop Support office is located in C-174. 


